
 
 
 
 
 

 

Project Manager’s Overview 
 
Project Manager is designed to control projects that 
have many individual tasks and have the potential for 
significant change.   PM provides a process that quickly 
shows the impacts of new  tasks and changes on the 
project bottom line.  

 
Put figuratively, PM   draws a circle around your project and deals with anything that 
crosses that boundary – new work, increases in old work,  procedures, and physical 
changes. 
 
Five on-line forms are used to identify the new  task or problem, resolve, 
and document all issues and costs.  Coupling the familiar use of 
management forms w ith a powerful totally behind the scenes database 
and email notifications provides management w ith needed information. 
 
Project Manager is designed as a task oriented management tool for use on all 
types of projects in all types of industries including construction projects, IT 
development projects, municipal renovation projects, and commercial new builds.  
Wherever interaction between groups of people occur, Project Manager’s unique 
perspective increases communications and ensures that daily problems are identified 
and resolved as soon as possible. 
 

No other project management system is easier to use or more cost 
effective in terms of both monthly cost and your valuable time! 

 
Project Manager  is an online web based system project management system.   
This means a lot to the user!  Never again will you have information scattered among 
many computers or will you have to wait while you find someone who can run the 
project management program or unlock a specific computer.  With Project 
Manager your information is stored in one secure place and is available whenever 
you want it. 
 
Nothing is stored on your computer.  Additionally, with PM’s ease of operation, no 
special training is necessary and information and all data, responses, directions, and 
decisions are on-line and available to you 24 x 7 - whenever and wherever it’s 
needed! 
 

PROJECT MANAGER 
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Project Manager  has been designed and built by professionals who have been 
there and we recognize that to be successful the program must be simple and logical 
in operation. In this regard, we believe we have succeeded.  We believe that Project 
Manager  is very simple to use and will require the average user less than an hour 
to be functional. 
 
The attached manual is a good source of information but really the best approach is 
to jump right in. 
 
 

1. First of all, understand the operation – you work on the forms and the 
database looks over your shoulder! 

 
2. When a new task or problem is identified, the user fills out an RFI (on-line) – 

an email is sent to all project parties. The form presents a situation that a 
manager must address; either add the new work task or resolve the problem. 

 
3. If new work is defined or the resolution of the problem will create new work, a 

variance exists in the project and a VN form is filled out by clicking a button 
on the RFI.  Again, the project team is alerted via email that a new variance 
exists. 

 
4. Management reviews the RFI/VN documentation and decides on a course of 

action.  Depending on the type of work identified, the manager can: 
 

o Authorize new work  
o Process a back charge to recover cost associated with supplier issues 
o Process a non-conformance to deviate from plans, methods or 

procedures 
  
Project Manager uses five industry standard looking forms to link all project parties 
together to identify new scope, changes, communicate issues to project parties, 
provide information to make a resolution, communicate resolutions to the project, 
and document all results.   
 
The five forms include: 
 
 RFI – identifies questions / problems from contractors 

 VN – identifies a project variance from scope or schedule 

Jump Right In!  
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 BCN – identifies a supplier back charge equipment or services issue 

 WA – identifies a work authorization 

 NCR – identifies changes in methods, quantities, criteria 

 
The first step in the overview process would be a general run through of the menus 
– everything is done with the menus – no programming or setups are necessary.  
Start with the Main Menu and see where new RFIs and Variances are created.  Next 
select the Edit Menu to see how all of the five forms are edited. The Reports Menu 
list all reports available – just select a report and it’s there. 
 
Common Data Tables should be the next stop in the overview process.  These tables 
hold key project information such as company names and addresses, personnel, 
problem categories, and cost codes.  It is suggested that you input as much 
information here as possible.  The forms are self explanatory.  The Common Data 
Tables are the source of the information that shows in pull down menus on all of the 
forms. 
 
Basically that’s all there is – go to the Main Menu, select “Add A New RFI” and begin.  
Enter all the data you can – you can always edit what you entered – select the 
Submit button at the bottom and you’ve started.  You can print the form by selecting 
the Print button or go to the Reports Menu and select the RFI Log to see you’re 
input. 
 
You never saw the powerful data base behind the scenes – we tried to make it very 
simple. 
 
About the Project Team…. 
 
Project Manager  would be of limited use if only the project manager were 
involved and hence the next step in the process …. bring the rest of the project into 
the system.  Once the project is set up with common tables, the manager creates 
sub-users from the Main Menu – Edit Profile button.  The sub-users are the 
contractors, engineers, and architects in the project. The manager’s next step is to 
set up the sub-users and their levels of permission – right on the Main Menu. 
 
Notifying the sub-users of names and passwords allows them to enter the system 
and start contributing. 
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About Printing…. 
 
Printing reports is simple but different than what you are probably used to. The 
difference is that we are printing over the internet.  There is no security, hardware, 
or programming issues but you have to deal with an internet program like MS 
Internet Explorer (IE). Depending upon the IE settings for fonts, etc. your actual 
printout may need some tinkering before satisfactory results are achieved.  
 
Project Manager  works best with Microsoft Internet Explorer version 8 and above. 
If you are not currently using version 8 (or above), we recommend you upgrade for 
the additional features it provides.  For example with versions of IE below 8, page 
breaks in the report are not recognized. 
 
IE Setup – nothing fancy here, just a few suggestions.  First IE will add cumbersome 
headers and footers that eat up considerable space.  We recommend, the user open 
IE, select the File Menu Item, then select Page Setup.  The headers and footers IE 
inserts are displayed – just delete them. On the same Page Setup page, select 
Landscape format  (all reports are in landscape), and set the top margin at 1” and all 
other margins equal to 0.5 inch. Select OK and you are done.  You will be returned to 
the IE screen – select the print icon to print the report. 
 
It is strongly recommended that the user do a “print preview” and adjust any 
margins necessary to obtain the best print.  Project Manager  believes a print 
setting of “Size to Fit” @ 95% will result in the best printing. 
 
 
About Closing… 
 
Close all forms (RFI, VN, BCN, WA, and NCR) by selecting either of the two options 
at the bottom of each form:  “Submit” or “Return With No Change”.  These buttons 
will either save and close the files or not update the data and close the files.  Do not 
use the windows “X” in the upper right corner of the screen or the IE return button. 
Selecting either of these will lose the data entered on the form. 
 
Do not close a form by selecting the MS Windows “X” in the upper right 
corner of the screen menu. This w ill drop you out of the program and 
return the user to Internet Explorer. 
 
Close any report by selecting the MS Windows “X” in the upper right corner of the 
screen menu.  This will return the user to the Reports Menu. 
 
Exit the program from the Opening Screen by selecting the MS Windows “X” in the 
upper right corner of the screen menu. 



 8 

 

 
 
Project Manager is a powerful task 
management and change control 
program that provides the user with a 
process to identify new tasks, problems, 
changes in scope, time or money. It 
documents the issues, communicates 
the resolutions to all parties and 
maintains logs and reports covering all 
contractor and internal impacts of the 
change.  
 
 
 
 
 
 
Project Manager  addresses the fact that issues comes at the manager from all 
directions: both internal and  external to the project.  Issues arise when:  
 
 designs are incomplete, 

 owners / architects alter 
project scope 

 contracts are not definitive 

 project conditions change   

 
 
 
 
In order to succeed, the manager 
must address all issues from both 
inside and outside the project.   
 
 
 
Project Manager addresses any issue that crosses the project boundary. 
 
 

Section 1:  What Does The Program Do?  
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You enter Project Manager in one of two paths; changes that result 

from internal project issues and external issues.  The internal, question (RFI), path 
allows all parties to request and receive answers to design, operation, 
implementation, or other questions impacting the work.  However, the RFI often 
identifies additional missed scope and when this happens; the project has 
experienced a variance in scope and/or cost.  
 
The second path identifies an external project change and does not generate an RFI. 
In this case a project variance in scope and or cost (VN form) is identified from the 
outset.  
 

 
Comprehensive reporting gives management the visibility to ensure all questions are 
answered in a timely manner to minimize claims.  Reports document all changes and 
the overall impacts to the project for contract management. 
 
The Concept  
 

1. If a project member identifies a problem, he completes an RFI and an 
automatic email is generated notifying the entire project team of a 
problem.  

 

Section 2:  How it works! 
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2. For the situation where an issue enters the project from an external 

source, an architectural change for example, no RFI (question) is created 
but the project has incurred a variance and a VN form is needed. 

 
3. The manager reviews the RFI (or VN) and if the problem is a simple 

answer to a question, the response is provided and the information is 
logged to the database – no further work needed. – Issue resolved! 

 
4. If the manager reviews the RFI and determines extra work results from the 

RFI, the manager clicks the “Yes-Open the VN Form”  button, and a project 
variance is identified - a VN form is opened with all the RFI input 
information already entered. 

 
5. Project management reviews the VN and develops a resolution which could 

be: 
 

a) Do nothing – return RFI  or VN with comments to do no work 
b) Assign new work to a contractor 
c) Develop a non-conformance for installed work or equipment not to 

specification 
d) Create a back charge to recover incurred costs associated with 

equipment or services problems 
 
6. For the issues above: 

For a):   Mark the VN form closed – program will notify project 
members via email 
 
For b):   From the VN create a work authorization form – WA - send to 
contractor – parties notified via email 
 
For c):   From the VN form, create a NCR form detailing acceptance or 
rejection of the non-conforming issue.  Note: a rejection may involve 
sending out a new work authorization or backcharge to resolve 
 
For d): From the VN create a BCN – backcharge form and send to 
supplier – email sent to project and supplier if desired 

 
7. When work is complete, capture actual costs on VN and close the form 
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The Project:  The Old Town Theater project involves the restoration of an old theater 
in the center of town.  The project manager has hired an architect, engineers, and 
contractors to perform the work. Suppliers have started to deliver materials to the 
site. 
 
The Problem:  One day the carpentry contractor received 50 wooden panel doors for 
the project.  His scope is to remove old doors and hang the new doors.  However, 
upon receipt inspection, he noticed the doors are 2” too tall.  
 
Upon receipt of an RFI from the contractor advising of the problem and requesting 
direction, the project manager realizes that the doors have to be fixed and it is his 
job to ensure the project does not incur additional costs as a result of this supplier 
problem. 
 
Project Manager’s   process resolves the problem via the following steps:  
 
 The contractor submits an RFI requesting direction – an automatic email is 

sent out to all parties 

 The manager receives the RFI and recognizes that new work is created by the 
need to fix the doors – he creates a variance form (VN) from the RFI form 

 The manager discusses the problem with the contractor and arrives at a 
solution to repair the doors for $50 each. 

 The manager realizes the supplier of the doors has a responsibility to deliver a 
satisfactory product and creates a BCN form (back charge) and Letter from the 
VN form and issues them to the supplier of the doors notifying him of the 
problem. 

 The door supplier acknowledges the BCN and returns the letter with his 
direction on how to proceed – for this sample, assume the supplier directed 
that the doors not be shipped back to him but be repaired at the site – he 
accepts the BCN terms to repair the doors on site for $50 per door. 

 The manager issues a WA from the VN form authorizing the work. 

 When the WA is returned marked complete, the manager closes out the VN 
form with the agreed resolution - an agreed WA to perform the work for 
$2500 (50 doors @ $50 each), and an agreed BCN accepting the $2500 back 
charge.  The VN is closed with a net $0 impact to the project. 

 
Section 3: A Sample to Show Operation 
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Documentation created by this change: 

RFI – identifying the problem 

VN – a variance created by the extra work 

BCN – issued to collect funds to correct the problem 

WA – issued to contractor to authorize extra work 

 
Reports will show a variance with a net to the project of $0, and WA increasing a 
contractor’s scope $2500, and a BCN back charging the supplier $2500. 
 
The overall elapsed time to complete and process the change will take a few days to 
get the emails returned, but the forms, because data is entered only once, take only 
a few minutes.   
 
And, more importantly, a process of change management is established. 
 
The process is simple, quick, and effective. 
 
Email Notifications: 
 
Every time a form is created or edited, an e-mail notification can be sent.  This 
immediately notifies the project of a change.  Often, because of quick notifications, 
changes are identified and resolved in the same day thus minimizing project impacts 
and reducing risks. 
 
A typical notification – the user adds a distribution and sends to the project 
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To start Project Manager, use your internet service to access the website: 
www.sitemanageinc.com. 
 
Navigation around the menus is performed with a mouse.  All selections are single 
left mouse clicks. All command buttons are large and rectangular in shape. All pull 
down menu selectors are small inverted triangles on the right side of a data entry 
location. 
 
Opening Screen 
 
When the website opens, click on the 
“Enter Program” button at the top left of 
the website main page, and the opening 
screen appears. On the opening screen, 
enter your Logon name and password 
and click the “Sign On” button. The Main 
Menu will appear if you have entered a 
valid name and password. 
 

 
 
 
 
After a successful logon, the Main Menu opens. 
 
The Main Menu 
 

 
The Main Menu form is the starting 
point for all program operations.  
 
From there, the user can: 

• Add new RFIs  
• Add a new Variances (VN) 
• Edit previously created forms 
• Maintain common data tables,  
• Run reports, and  
• Edit your sub-user’s profiles.   

 

Section 4:  Program 
 

http://www.sitemanageinc.com/�
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The “Add A New RFI” button opens a new blank RFI form.  The “Add A New 
Variance” button opens a new blank VN form.  The “View/Edit Forms” button opens 
the Edit Menu, The “Common Tables” button opens the Common Data Tables Menu. 
The “Reports” button opens the Reports Menu, and, the “Edit Profile” opens a special 
sub-user form to add/edit sub-users of the program. 
 
The user selects the desired operation by a single mouse click.  
 
 
The Edit Menu 
 
The Edit Menu has command buttons that 
allow editing of any of the previously 
created forms; Request for Information 
(RFI); Variance (VN); Backcharge (BCN); 
Work authorization (WA); and Non-
conformances (NCR). 
 
To edit a form, click on the pull down 
menu for the desired form under the 
“Select Form #”.  Highlight the desired 
form number with a single left mouse click 
and then click the “Select Button” for that 
form.   
 
The form will open and any edits can be made.  All forms are edited in the same 
manner.  When all changes to the form are complete, selecting the “Submit” at the 
bottom of the form saves the data and closes the form.  Forms can be edited as 
many times as necessary.  The “Return With No Change” button at the bottom of the 
form,  cancel’s all inputs and returns the user to the Edit Menu. 
 
The Reports Menu 

 
The Reports Menu is accessed from the 
Main Menu.  The Reports Menu uses 
simple pull down menu selectors to select 
specific reports.   
 
The Reports Menu is in three parts; the 
upper part shows all RFI specific reports, 
the middle section shows all VN, BCN, 
WA, and NCR reports and the lower 
section contains Contract Change reports.  
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To run a report, select a report name from the pull down list and press the command 
button marked “Run Report”.  After answering print range questions on pop-up 
boxes, the report should appear. 
 
For restricted users, only the RFI Reports are available. 
 
 
The Common Data Tables 
 
The seven (7) Common Data tables 
are where frequently used 
information is stored. Data entered in 
these tables is available for the pull 
down menu selectors that are on 
every form. Adding as much 
information as possible in the 
Common Data forms will greatly 
speed up data entry and accuracy. 
 
 
 
Once entered, information such as phone numbers, contact information, names, 
addresses, etc. are available to all forms.  
 
 
The tables are: 
 
Title Block: This table is used to define either a project title or project item.  
 
Companies: This table contains a list of all companies or component information 
involved in the project. The information includes name, address and contact 
information. 
 
Discipline: Defines the discipline breakdown such as piping, civil, etc. 
 
Cost Codes:  This table is a listing of the allowable cost codes (and description) to 
charge work. 
 
Personnel:  This table provides a list of name and titles to select from. 
 
Problem Category:  This table contains listing of type of problems such as shipping 
damage, engineering, damaged during construction, etc. 
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Change Orders:  This table defines contract identification numbers.  Assign a 
number here and then, through the VN form, assign specific variances to the contract 
number. 
 
The Edit Profile Form 
 
 
The main user is allowed 
to have up to five sub-
users that can have 
different use 
permissions.  
 
Sub-users are other 
parties or contractors 
involved in the project 
and they can have 
complete or restricted 
levels of program 
access. 
 
To add a sub-user, the main user inputs the data to the required fields, and selects 
the user permission type from the pull down menu.   
 
Selecting the “Add User” button, completes the process and adds a new sub-user.   
At the bottom of the form is a listing of already assigned sub-users. 
 
The main user may assign any one of the following to a sub-user: 
 
 Full Access – allows all function – editing and updating 
 RFI and RFI Reports – lets user create RFIs and read/print RFI reports 
 Read Only – allows user to read all forms and reports – does not allow any 

changes  
 Read Only RFI - allows user to read only RFI forms and reports – does not 

allow any changes  
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The user completes the form sections by typing in the blank fields.  Using the pull 
down menus for commonly used names, addresses, and types of problems quickly 
speeds up form completion. When data entry is complete, the user can print the form 
by selecting the command buttons in the upper right corner of each form.  Selecting 
the “Submit” button in the bottom center of each form saves the data and closes the 
form. Selecting “Return with No Change”, returns control to the menu and does not 
update the data. 
 
Each form has email notification.  When the “Submit” button is selected, the program 
displays a message asking if the user wants to send an e-mail notification.  An e-mail 
notification should be sent whenever a form is created or edited.   Selecting “yes” for 
the e-mail question will open the e-mail program with an attached message stating:  
 

This is RFI “XX”.  Please open program to view this RFI”.   
 
All forms are completed in the same manner.   
 
The  RFI Form: 
 
The first step in creating a new RFI starts with the Main Menu.  The user selects 
“Add an RFI” and a blank RFI form appears.  A unique RFI number is already 
inserted into the field provided -  this cannot be changed. An RFI form, similar to the 
one below, appears.  Enter all available data in the blank fields.  Use the pull down 
menu selectors to assist in input.  You can always go back through the Edit Menu to 
change or add information. 
 
If the RFI simply asks a question and does not generate new work, it stands alone 
and does not have any other form associated with it.   
 
If new work results from the RFI, then a variance in the 
project scope exists and a project variance form needs to 
be created. In cases like these, there is a provision in the 
upper right corner of the RFI form to select the button 
“Yes – Open VN Form”.  This links the RFI and the VN form and shares all data 
entered for the RFI with the VN form and automatically opens a new VN with the 
same number as the RFI. 
 

Section 5:  Completing the Forms 
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In cases where a change comes from an external source and no RFI is created,  a VN  
(variance) is created directly from the Main Menu.  WAs, BCNs, and NCRs, if 
necessary,  can be created from the VN form. 
 
 THE RFI FORM 
 
Note: 
 All data is entered directly into the fields on each of the forms. 
 All data entered on the RFI will automatically be carried over to associated 

forms 
 
 
 
• Heading 
 
 
• Part A – initiating 

company 
 
 
 
• Part B – Problem 

Description 
 
 
 
 
 
• Part C – Problem 

Response 
 
• Part D - 

Comments 
 
 
• Part E – 

Completions / 
Authorizations 
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Heading Inputs: 
 

 
 
 Project No:  use pull down information to fill this and the following two lines. 

The second and third lines can be user entered or edited 
 
 RFI No: is entered automatically – no editing is allowed 

 
 RFI Rev No:  (to right of RFI No) – direct entry 

 
 Delete Button: deletes the RFI – if a Variance was created with the RFI, the 

VN is not deleted and must be deleted separately 
 
 Print Button:  prints the complete form on 8 ½ x 11 paper. Note: using a color 

printer makes forms standout on your desk. 
 
Part A:  Initiating Company 
 

 
 
Part A has four inputs. 
 Originator:  <person creating RFI> selecting the pull down here accesses the 

information in a common table and populates all of the fields associated with 
the originator 

 
 Date Issued: <date RFI created> enter the date the RFI is issued  

 
 Resp. Req’d By: <date response is required by>  enter the date a response to 

the RFI is required 
 
 “Yes – Open VN Form”:  select this button only when an RFI creates extra 

work.  Selecting this button opens a new VN form linked to the RFI* 
 
* Note: The user should complete as much of the RFI form as possible before 
selecting (clicking) the “Yes – Open VN Form” button.  Missing information can be 
entered on the VN form.  Do not click the “Submit” button on the RFI. 
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Part B: Problem Description: 
 

 
 
 
Part B: This section defines the RFI problem. The fields in this section include: 
 
 Reference documents:  <enter the names of applicable reference documents> 

enter data directly into box 
 
 Affected Contractor: <contractor impacted by RFI> use pull down to select 

from list of predefined contractors – direct entry allowed 
 
 Problem Category:  <identify problem type> use pull down to select from list 

of categories 
 
 Problem Description:  <defines the category of the change> use pull down to 

select from list 
 
 Discipline Reference: <a discipline reference> use pull down menus to enter 

relevant discipline 
 
 Short Description:  <a brief description of problem> enter a short description 

of problem 
 
 Detail Description:  <enter a detail description of problem> 

 
Part C: Problem Response 
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Part C has three inputs 
 
 Response By:  <enter the date a response is required by> select from pull 

down menu – title is automatically added from Common Table data 
 
 Date:  <enter the date a  response is given> 

 
 Response:  <enter a detail description of problem> enter the directed 

response to the problem 
 
 
Part D:  Comments 
 

 
 
 Comments:  enter any special comments associated with the change 

 
Part E: Completions and Authorizations 
 

 
 
Part E: has six inputs 
 
 Authorized By:  <authorizing project manager> select from pull down menu to 

enter the person’s name authorizing the change. 
 
 Date: <enter authorizing date> the date the authorizing person authorizes the 

RFI action 
 
 Status:  select from the pull down menu list proving the status of the change – 

no direct input allowed 
 
 Resolution Date:  <date RFI answered> enter the date the change is resolved 

 
 Submit:  <Submit button saves data and closes form> when data entry is 

complete saves data and updates the database  
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 Return to Menu:  select the Return to Menu button when the user wants to 

discard all changes made to form.  No data is updated to database. 
 
The VN Form (Main Variance Form) 
 
The VN form is the “parent variance” document for all project scope change 
information. The VN form is the repository of all change information, costs incurred, 
resolutions arrived at, and directed actions.  
 
To further document costs, resolutions, and assignments of new work, the VN form 
can create a work authorization (WA), a back charge notice (BCN) and/or a non-
conformance in design or execution (NCR).   
 

All information 
entered on any form 
is transferred to the 
database and is 

automatically 
available to all other 
forms.   
 
Each of the children 
forms (WA, BCN, 
NCR) have places to 
enter final cost 
impacts.  The VN form 
has a section that 
allows the user to 
enter the estimated 
cost impacts.  This is 
useful in situations 
where the VN is open 
and final costs are not 
available.  
 
 

 
The VN form documents all associated costs and schedule impacts. 
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VN Heading:  (see RFI – input is same) 
 

 
 
The VN form is used to add new work or address any changes. 
 
VN Part A: Associated Documents: 
 

 
 
Part A:  Creates the WA, BCN, and NCR forms.  After the VN is created, the user can 
create a WA, BCN, or NCR at any time by using the edit process – open a specific VN 
through the Edit Menu and selecting one of the create buttons. 
 
 Select for WA:  this button creates a new WA from the parent VN form – WA 

number will be same as VN number 
 
 Select for NCR: this button creates a new NCR from the parent VN form – NCR 

number will be same as VN number 
 
 Select for BCN: this button creates a new BCN from the parent VN form – BCN 

number will be same as VN number 
 
VN Part B: Originator Information 
 

 
 
 
Part B has one text input and two date inputs; 
 
 Originator: <enter name of person originating change> this field is a pull 

down menu that selects the user from common table entered data. Direct 
entry is not allowed 

 
 Originator Date:  <date change was identified> the date in mm/dd/yyyy 

format defines the date the change originated 
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 Required Response By: <date a response is needed by> this date in 

mm/dd/yyyy format is the date when a response to the query is expected. 
 
 
VN Part C:  Problem Description 
 

 
 
VN Part C:  has four text inputs, six “Yes/No” selectors for change differentiation, and 
five pull down menus 
 
 Variance Impacts (Yes/No items) 

 
o Variance Valid:  manager’s opinion if change is warranted 
o Back charge:  manager’s opinion if change is back chargeable to a 

supplier 
o Subcontract Change: manager’s opinion if change results in an increase 

in a subcontract 
o Directs:  manager’s opinion if change impacts direct accounts 
o Budget Variance:  manager’s opinion if change is in current budget 
o Main Contract Change:  manager’s opinion if change impacts Main 

contract with owner 
 

 Vendor Affected: <enter the name of vendor that will be impacted> select 
from pull down menu to input supplier impacted by change 

 
 Subcontractor Affected: <enter the name of the subcontractor that is 

impacted> select from pull down menu to input subcontractor impacted by 
change 
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 Problem Category:  <enter the category of work> select from pull down menu 

to input category of change 
 
 Classification of Problem:  select from pull down menu to input classification of 

problem 
 
 Discipline Reference:  select the discipline from pull down menu 

 
 Reference Documents:  <enter the necessary reference documents that 

involve the change> input documents identifying change, drawings / 
specifications, etc. impacted 

 
 Short Description:  <enter a brief ~10 word – description> enter a short  

word description of change 
 
 Detail Description: <enter a detailed description of change> enter a detail 

description of change – detail location – existing conditions - safety issues, 
etc. 

 
 Problem Resolution:  <completed by manager – describe problem resolution> 

– team’s response to problem – provides directed action. 
 
VN Part D:  Cost and Schedule Impacts 
 
 

 
 
Add cost code (account numbers) for the work through the Common Data tables.  
Select a cost code from the pull down menus to provide an account to accumulate 
the charges for execution of the variance. Two sections of cost information are 
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provided.  The first labeled “Estimate Data” can be used to reflect original 
information.  The second section labeled “Final Cost Data” represents the final cost 
impact of the variance. 
 
All cost information entered on the shortened cost section of the WA, BCN, and NCR 
forms will update the “Final Cost Data” fields of the VN report.   
 
Part D:  contains the cost impacts of change.  For six cost categories, input cost 
accounts, hours and costs for estimated costs and, when information is final, hours 
and costs for final change costs. 
 
 Cost Codes: <project or accounting codes used to summarize work> select 

from pull down menus to input the cost code to which this cost category is 
assigned 

 
 Hours:  <enter work hour estimates for effort> enter the estimated number of 

hours the change will take for each cost category 
 
 Costs:  <enter dollars> enter costs associated with hours and cost category 

 
 Hours (final):  enter the final change costs associated with cost category 

 
 Costs (final):  <dollars> enter final costs associated with change cost category 

 
 Schedule Impact:  use pull down menu to select level of schedule impact 

 
 Schedule Delay: <In days>  enter the number of days this change will make 

in the project – elaborate in Comments if necessary 
 
 Proj. Engr:  <authorizing engineer> use pull down menu to enter name of 

engineer authorizing the change 
 
 Date:  <enter engineer/architect’s approval date> in mm/dd/yyy format for 

the date of the change 
 
 Authorize: <enter authorizing project manager> use pull down menus to enter 

manager’s name authorizing the change 
 
 Date:  <enter project manager approval date> date in mm/dd/yyy format of 

date manager approves the change. 
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VN Part E:  (page 2) Comments 
 

 
 
Part E: contains only a “Comment” field.  This should be used to document any 
unusual issues or schedule impacts 
 
VN Part F: (page 2) Close Out – Contract Change Assignment 
 

 
 
 
Part F: Close Out  (two sections; a “close out” section and a contract assignment 
section) 
 
 Work Complete:  <enter date work is complete> this date is the date when 

the change is complete. The pull down menu assign a name of a person 
attesting work is complete 

 
 Eng/QA Inspection Complete: <enter date and person of QA approval 

complete> enter date and person from pull down menu of QA inspector who 
confirms that the work is complete to acceptable standards 

 
 Change Order Number: <enter the contract change number this change is 

associated with> The pull down menu shows a listing of contract numbers to 
which the change can be assigned.  Selecting a contract number links this 
variance to a specific contract change order 
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VN Part G:  Signature and Status 
 

 
 
Part G: provides a place on hard copy form for final authorizing signature. 
 
 Status:  use the pull down menu to input a status for the VN form. Default is 

“VN Open”  
 
 
Deleting Forms: 
 
There is a delete button at the top of each form.  Selecting the delete button on any 
forms will delete the form. However, there are rules to the deletion process. The user 
needs to follow these to avoid deletion of needed information: 
 
Rule 1: RFI form – if the RFI has no associated variance (VN) form, deletion deletes 
the RFI – however, if a VN is associated, deleting the RFI does not delete the VN 
 
Rule 2:  deleting any child form (BCN, WA, or NCR) deletes that form only and does 
not delete the parent VN form 
 
Rule 3:  deleting the VN form deletes all associated children forms 
 
Note: Once a VN is deleted, the master record is gone.  There is no undelete – be 
careful. 
 
BCN / WA / NCR Forms 
 
All children forms have data entered in the same manner as the RFI and VN forms.   
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The Back Charge Form  
 
(BCN)  (used to recover costs associated with faulty materials and/or services).  To 
get to the form below, the user logs onto the program and arrives at the Main Menu.  
From the Main Menu, the user selects the “Edit Forms” button.  This opens the “Edit 
Menu” where the user selects the pull down selector next to the BCN line.  The pull 
down selector on the BCN line shows all available BCNs stored in the system.  The 
user highlights a BCN and selects the “Edit This BCN” and the form appears. 
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The only significant difference in data entry on the 
BCN form from all the other forms is the 
command button, “Create BCN Letter” in the 
middle of the BCN form.  
 
This button, when selected, will create a form 
back charge letter, similar to that to the right. The 
letter contains all description information and the 
proposed resolution – if available. It’s intended 
use is to: (1) notify a supplier that a change is 
being processed, (2) notify the supplier of a 
proposed solution, and (3) identified estimated 
cost.  The BCN Letter requests the supplier 
complete and return the form and advise the 
project on his preferred method of solution of the 
problem.  The project manager uses the BCN Letter’s response to determine how to 
proceed. 
 
This usually time consuming process is reduced to a few keystrokes. 
 
The BCN form contains the following sections: 
 

• BCN: Heading  
• BCN Part A: Description of Project 
• BCN Part B: Vendor Information 
• BCN Part C: Corrective Action 
• BCN Part D: Estimated Costs 
• BCN Part E Approvals /Authorizations 

 
Note:  The following section described the inputs for each field on the BCN.  
However, since the BCN is created from a VN form, most of the fields will already be 
filled in. 
 
BCN: Heading 
 (input is same as for the RFI and VN forms) 
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 Project No: <project/contract number> use pull down information to fill this 
and the following two lines. The second and third lines can be user entered or 
edited. 

 
 BCN No: is entered automatically <same as VN number> – no editing is 

allowed 
 
 BCN Rev No:  <BCN revision number> (to right of BCN No) – user defined 

direct entry 
 
 Delete Button: deletes the BCN – if a Variance was created with the BCN, the 

VN is not deleted and must be deleted separately. 
 
 Print Button:  prints the current form on 8½ x 11 paper. 

 
 
BCN Part A: Description of Project 
 

 
 
 Short Desc of Error:  <brief description of problem ~ 10 words> direct entry 

of problem – short description – used in report headings 
 
 Detail of Error: <detail description of problem> direct entry - complete 

description of problem 
 
Note: orange section shows all other related forms – do not enter changes in this 
section 
 
BCN Part B: Vendor Information 
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 PO#:  <supplier of problem material> use pull down menu to fill in all 
vendor/supplier fields – direct entry allowed 

 
 Vendor Accepts Responsibility: select yes or no from list 

 
 Action By Owner: select yes or no from list 

 
 Action By Vendor: select yes or no from list 

 
 Notify Date:  <date supplier notified> enter date vendor was notified of 

problem 
 
 Notification Type: <type of notification> enter text describing form of supplier 

notification (mail, email, verbal, etc.) 
 
BCN Part C: Corrective Action 
 

 
 
 Originator:  <originator of BCN>  use pull down menu to select a name of 

person directing the corrective action  
 
 Originator Date:  <date BCN created> enter date, mm/dd/yyyy format, of 

when back charge was initiated 
 
 Ref Doc:  <reference documents contributing to BCN> enter text describing 

reference documents impacted by problem 
 
 Corrective Action To Be Taken: <problem resolution> enter text describing 

problem resolution  
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BCN Part D: Estimated Costs 
 

 
 
 Back charge Cat:  <back charge reason> select from pull down menu or direct 

entry 
 
 Recovered Hours: <work hours supplier is willing to pay for> direct entry of 

number of hours 
 
 Recovered Cost: <dollars supplier has agreed to pay in compensation for 

problem> direct entry of dollars  
 
 Complete Date: <date BCN negotiations complete> direct entry of date 

 
 Complete By:  <name of person responsible for BCN resolution> direct entry 

of persons name 
 
 Comments:  <special comments related to BCN> direct entry of any 

comments pertaining to BCN resolution status 
 
 Cost Table <enter all FINAL costs> select Cost Code from pull down selector 

or direct entry – enter hours and dollars into fields 
 
 Basis of Compensation: <how BCN costs are recovered> enter description of 

how repayment for faulty work is recovered 
 
BCN Part E: Approvals /Authorizations 
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 Signature:  <approver hard copy signature>  no entry on form – used for 
signature on hard copy of form 

 
 Date:  <date approver signed form>  no direct entry – date entered on hard 

copy of form 
 
 Submit: - Command Button  <submits form data to the database>  a single 

left mouse click to select – enters all form data and saves all information 
 
 Return with No Change: -Command Button  <closes form without updating 

database>  – does not save data 
 
 BCN Status:  use pull down menu to select from a list of BCN status conditions 

– no direct entry allowed 
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 Work authorization (WA)  (used to document assignments of new work) 
 
The WA form contains the following sections: 
 

• WA: Heading from Stored Data 
• WA Part A: Contractor Performing Work 
• WA Part B: Problem Category 
• WA Part C: Required Action 
• WA Part D: Work Activities and Estimated Costs 
• WA Part E Approvals /Authorizations 

 
Note:  The following section described the inputs for each field on the WA.  However, 
since the WA is created from a VN form, most of the fields will already be filled in. 

 
 
 
 
 
To get to the WA form at 
the right, the user logs 
onto the program and 
arrives at the Main Menu.  
From the Main Menu, the 
user selects the “Edit 
Forms” button.   
 
This opens the “Edit 
Menu” where the user 
selects the pull down 
selector next to the WA 
line.  The pull down 
selector on the WA line 
shows the available WAs 
stored in the system.  The 
user highlights a WA and 
selects the “Edit This WA” 
button and the form 
appears. 
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WA: Heading from Stored Data 
 

 
 
 See VN form for Heading description 

 
WA Part A: Contractor Performing Work 
 

 
 
 Purchase Order:  <contractor being assigned new work> use pull down menu 

to select subcontractor – all other fields are filled in from database – direct 
entry allowed 

 
 Originator: <person authorizing new work> use pull down selector to enter 

the name of person responsible for new work 
 
 Originator Date: <date this change was identified>  direct enter data when 

change was identified 
 
 Notification Date:  <date contractor notified of new work> enter date when 

WA is authorized 
 
 Notification Type:  <form of notification> email, regular mail, verbal, etc. 

 
Note orange section to right shows all other related forms – do not make changes in 
this area 
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WA Part B: Problem Category 
 

 
 
 Category of Error: <type of problem WA written to fix> use pull down selector 

or direct entry 
 
 Reference Documents:  <note any special reference documents that address 

the scope of the WA>  direct entry into form 
 
 Status of Work: <WA status>  use pull down selector to define condition – no 

new entry allowed 
 
 Work Complete Date: <date work is approved as complete> direct enter date 

 
WA Part C: Required Action 
 

 
 
 Required Action:  <description of work to be performed> direct entry onto 

form 
 
WA Part D: Work Activities and Estimated Costs 
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 Cost Table <enter all FINAL costs> select Cost Code from pull down selector 
or direct entry – enter hours and dollars into fields 

 
 Comments:  <enter any special comments> 

 
WA Part E: Approvals /Authorizations 
 

 
 
 Signature:  <approver hard copy signature>  no entry on form – used for 

signature on hard copy of form 
 
 Date:  <date approver signed form>   direct entry – date entered on hard 

copy of form 
 
 Submit Button:  <submits form data to the database>  a single left mouse 

click to select – enters all form data and saves all information 
 
 Return with No Change Button:  <closes form without updating database>  

selecting button closes form without updating database – does not save data 
 
 QA Inspector:  <quality inspector verifying acceptable work> use pull down 

menu to select from a list of names  – direct entry allowed 
 
 Approval Date: <date QA Inspector approved work> direct entry of date onto 

form 
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The Non-Conformance Report (NCR)   
(used to document impact of design or work conditions changes) 
 
The NCR form contains the following sections: 
 
 NCR: Heading from Stored Data 
 NCR Part A: Contractor Performing Work 
 NCR Part B: Problem Category 
 NCR Part C: Required Action 
 NCR Part D: Work Activities and Estimated Costs 
 NCR Part E Approvals /Authorizations 

 
 
 
Note:  The following section described the inputs for each field on the NCR.  
However, since the NCR is created from a VN form, most of the fields will already be 
filled in. 
 
 
 
 
To get to the NCR form 
at the right, the user 
logs onto the program 
and arrives at the Main 
Menu.  From the Main 
Menu, the user selects 
the “Edit Forms” button.   
 
This opens the “Edit 
Menu” where the user 
selects the pull down 
selector next to the NCR 
line.  The pull down 
selector on the NCR line 
shows all the available 
NCRs stored in the 
system.  The user 
highlights an NCR and 
selects the “Edit This 
NCR” and the form 
appears. 
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NCR: Heading  
 

 
 
See VN form section for input to this section 
 
 
NCR Part A: Contractor Performing Work 
 

 
 
 Originator: <person authorizing new work> use pull down selector to enter 

the name of person responsible for new work 
 
 Originator Date: <date this change was identified>  direct enter data when 

change was identified 
 
 Reference Documents:  <note any special reference documents that address 

the scope of the NCR>  direct entry into form 
 
NCR Part B: Problem Category 
 

 
 
 Category of Non-Conformance: <category of problem> use pull down selector 

or direct entry 
 
 Material Description:  <a text field that allows user to define specific material 

issues> direct form entry 
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 Item No:  <a text field that allows the user to identify a specific item number 
from a drawing, report, etc.> direct form entry 

 
 System No.: <a text field that allows the user to identify a system identifier 

from a drawing, report, etc.> direct form entry 
 
 Short Desc: <a brief description of the out of conformance issue> direct form 

entry 
 
 Detail Description: <a detailed description of the non-conformance> direct 

form entry 
 
 
NCR Part C: Work Activities and Estimated Costs 
 

 
 
 
 Responsible Party Information: <enter the company responsible for the non-

conformance>  use pull down selector to select a company – selector fills in 
lower fields – direct entry is available 

 
 Notify Date:  <date supplier notified> enter date vendor was notified of 

problem 
 
 Notification Type: <type of notification> enter text describing form of supplier 

notification (mail, email, verbal, etc.) 
 
 Disposition:  <enter problem resolution> direct form entry 

 
 Cost Table <enter all FINAL costs> select Cost Code from pull down selector 

or direct entry – enter hours and dollars into fields 
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NCR Part D: Comments 
 

 
 
 
 Comments:  <a text field that allows the user to enter any relevant 

comments> direct form entry 
 
 
 
NCR Part E:  Approvals /Authorizations 
 

 
 
 Signature:  <approver hard copy signature>  no entry on form – used for 

signature on hard copy of form 
 
 PM Authorized By: <enter authorized manager’s name>  use pull down menu 

selector or direct entry 
 
 Engr Authorized By:  <enter authorized engineer’s name> use pull down 

menu selector or direct entry 
 
 Date:  <date approver signed form>   direct entry – date entered on hard 

copy of form 
 
 Submit: - Command Button  <submits form data to the database>  a single 

left mouse click to select – enters all form data and saves all information 
 
 Return with No Change: - Command Button  <closes form without updating 

database>  selecting button closes form without updating database – does not 
save data 
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 EA/QA Inspection Complete:  <quality inspector verifying acceptable work> 
use pull down menu to select from a list of names  – direct entry allowed 

 
 Date: <enter date EA/QA inspection is accepted>  direct form entry 

 
 Work Complete: <date worked complete> direct form entry 
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Section 6: Overview of Reports 
 
 
 

 
The following 
process produces 
all reports.  
 
 From the Main 
Menu, select the 
button “Reports” – 
the Reports Menu 
should appear.  All 
reports, except the 
BCN letter, are 
created from the 
Reports Menu to 
the right. 

 
On this menu are three categories of reports.  The RFI reports are accessible by all 
project parties.  Variance and Contract reports, due to the sensitive nature of some 
information, are available only to people authorized by the manager.   
 
The second group of reports, Variance Reports and Logs contain cost and status 
reports for variances, work authorizations, back charges, and non-conformances.  
This group is accessed only with high level permissions.  The third group of reports is 
contract summarization reports and again is visible only with high levels of 
permission. 
 
Adding An Alternate User 
 
Project Manager allows the Main User to create alternate users so that 
subcontractors, engineers, other managers, etc. can actively participate and access 
the program. Each alternate user can be assigned a different level of access 
consistent with his project responsibility (full access, RFI and RFI Reports, Read Only, 
Read Only RFI). 
 
The levels of permission or authorization are set by the main user from the Main 
Menu -> Edit Profile button.  The Authorized User screen provides main user 
information (which can be updated) and a set of fields on the right of the screen that 
allows identification of Alternate Users.   
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Selecting this button opens the Authorized Users screen where the manager sets the 
level of permissions for each user. The process of assigning an alternate user is as 
follows;  (1) assign and enter in the field a user name, (2) assign and enter a new 
password, (3) select from the pull down menu the permission desired for the 
alternate user and (4) click on the ‘Add User” button.  The table below the Alternate 
Users section shows all alternate users identified. 
 
Edit and Delete buttons are available to Edit or Delete Alternate Users.  When 
complete, click on the “Submit” button. 
 

 
 
 

Running a Report 
 

To run a report, the user selects 
one of the three report lists (RFI, 
Variance, and Contract)  pull 
down menu selectors and a 
listing of available reports will be 
displayed – similar to that at 
right 

 
 

Select a report from the list by highlighting it with a mouse click and the  report will 
be highlighted.   
 
The next step in running the report is selecting the “Run Report” button. 
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After the “Run Report” button is selected, two pop up forms appear where the user 
defines the range (i.e. start point to end point).  In the first pop up form, the user 
enters the beginning RFI number (or VN, BCN, WA, or NCR number depending on 
report). The second pop up form is where the upper limit RFI (or VN, BCN, WA, or 
NCR number depending on report) is entered.  This sets the range of printing for the 
report.   
 
After pressing OK on the last range pop up, 
another popp up forms appears where the user 
tells the program to print all records or just the 
open records. Selecting “OK” restricts the 
report to only open records.  Selecting “Cancel” 
prints all records in the database that meet the 
range restriction.  
 
 
 
 
After this, the report should appear.  To obtain the best print quality, however, the 
user should go to the Internet Explorer menu and select File – Page Setup. 
 
The user should then select landscape format with the top margin set at 1” and all 
others at 0.5” – select OK and report will appear – ready for printing – select File 
Print to final print the report. 
 
All reports are run in this fashion. 
 
Selecting the “X” in the upper right corner closes the report and returns the user to 
the Report Menu. 
 
Important Printing Notes: 
 
Eliminate Internet headers and footers: Internet Explored uses default headers 

and footers that take up valuable space.  Select the printer icon   and select 
Page Setup to find and delete the headers and footers 
 
Page Breaks:  The user should upgrade to Internet Explored 8 (or later) to see the 
page break capabilities. 
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